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Part 1: Overview 

Introduction 

 
Introduction eSTEPS is a suite of software that allows for the preparation and 

implementation of data collection using Personal Digital Assistants (PDAs).  

This User Manual provides instructions for use of all components of the 

eSTEPS software suite. 

 
Why eSTEPS? As a PDA-based data collection tool, eSTEPS provides the following 

benefits: 
 

• Immediate error-checking during data collection (e.g. inadvertently skipped 

questions or out-of-range responses) 

• Marked reduction of materials to be carried by data collectors (one PDA vs. 

hundreds of paper instruments) 

• No data entry needed 

• No cost for data entry 

• Fewer errors arising from data entry 

• Final dataset can be created quickly following completion of data 

collection. 
 

While eSTEPS does require the use of several PDAs (at least one per data 

collector), this additional cost is partially offset by the savings in data entry 

expenses.  If resources do not exist to purchase PDAs, consider pooling 

resources with other teams in your organization.  The PDAs can be used for 

other surveys and therefore they can be made available in your organization 

as a shared resource.  Alternatively, contact your WHO Regional Office to 

enquire about the possibility of borrowing WHO-owned PDAs for your 

survey. 

 
eSTEPS 

overview 
eSTEPS is comprised of 3 parts, which are illustrated in the figure below.  

The succeeding table gives a brief description of each component. 
  

 

 

 

 

 

 

 

 

 

 

 

 

 

Continued on next page 
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Introduction, Continued 

 
eSTEPS 

overview, cont. 
Component Description 

eSTEPS Questionnaire Designer 

Allows questionnaires to be designed 

and developed for use within the 

eSTEPS environment. 

eSTEPS Manager 

Provides resources to manage 

questionnaires and records (captured 

on the PDA), such as copying 

questionnaires to and from the PDA, 

copying records to and from the PDA, 

and exporting records to EpiData. 

eSTEPS PDA Software 

Presents a graphical user interface on 

the PDA through which the collection 

of record data can be administered.  
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Installation 

 
Hardware and 

Software 

Requirements 

While the entire eSTEPS software suite and all prerequisite software is freely 

available from the STEPS team or Microsoft, the installation of the software 

cannot proceed if the following hardware requirements are not met: 

 

• For the PDA (Pocket PC):  

o Operating System: Microsoft Windows Mobile 5.0 or later 

o Disk Space (ROM): at least 128MB 

o Memory (RAM): at least 64MB 

o Processor: preferably 520MHz range or greater 

o Buttons: preferably as few as possible 

o Screen Resolution: 240 x 320 pixels; 

• For the desktop (or laptop) computer:  

o Operating System: Windows 2000 (Service Pack 3), Windows 

XP (Service Pack 2), or Windows Vista. 

o Available disk space (ROM):  at least 500MB. 

 

If you are unsure of the compatibility of your hardware with the eSTEPS 

software suite, please contact the STEPS team (steps@who.int). 

 
Installation 

Guide 
The eSTEPS Installation Guide, which is available on the STEPS CD and the 

STEPS website (http://www.who.int/chp/steps/esteps/en/), provides detailed 

instructions on the installation of the eSTEPS software suite on your 

computer and PDA, including the installation of all prerequisite software 

needed to use eSTEPS.  Please read through this guide carefully before 

attempting to install eSTEPS. 
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eSTEPS File Types 

 
Introduction This section is intended to familiarize you with the different types of files 

used with the eSTEPS software.  These are: 

 

• .qml (eSTEPS questionnaire) 

• .rml (eSTEPS records) 

• .qes (EpiData questionnaire) 

• .rec (EpiData records). 

 
.qml files eSTEPS questionnaires are stored in .qml files that are generated and 

modified in the eSTEPS Questionnaire Designer. 

 

The .qml files are uploaded to the PDA where they provide the interface used 

during data collection. 

 
.rml files During data collection, the .rml are used to store the data recorded.  Thus the 

.qml files simply provide the interface, while the actual records are stored in 

the corresponding .rml file.  The .rml files are automatically generated by 

eSTEPS when you open a .qml file on your PDA and start collecting data. 

 
.qes files .qes files are EpiData questionnaire files.  EpiData is a data entry program 

that is normally used for data entry.  With eSTEPS, EpiData is simply used to 

assist in managing the records downloaded from the PDAs.  The .qes file 

corresponding to your eSTEPS questionnaire (.qml) file can be generated 

using the eSTEPS Questionnaire Designer.  This .qes file can then be used to 

make the EpiData .rec file (see next paragraph). 

 
.rec files .rec files are EpiData records files.  The .rec file for your questionnaire can be 

easily generated in EpiData from the .qes file containing your questionnaire 

template.  This empty .rec file will then be filled with the data from the 

eSTEPS record (.rml) files from the PDAs. 

Continued on next page 
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eSTEPS File Types, Continued 

 
File Diagram The figure below provides a graphical representation of how the 4 different 

types of files are used and generated. 

 

 

 

eSTEPS Questionnaire Designer 

.qml file .qes file 

PDA 

.rml file 

EpiData 

.rec file 

eSTEPS Questionnaire Manager 

EpiData 

Data exported to a wide variety of data 

format  types (e.g. dbase III, Excel, SPSS) 
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Part 2: eSTEPS Questionnaire Designer 

Introduction 

 
Introduction The eSTEPS Questionnaire Designer allows you to create new eSTEPS 

questionnaires and modify existing ones. 

 
Opening the 

Questionnaire 

Designer  

To open the Questionnaire Designer, click on your Start menu and select 

eSTEPS>eSTEPS Questionnaire Designer from your list of Programs. 

 

 
 

 
Exiting the 

Questionnaire 

Designer 

To exit the Questionnaire Designer, select File>Exit at the top of the 

Questionnaire Designer window. 

 
Starting a new 

questionnaire 
To start a new questionnaire, click on the "Create a new Questionnaire" button 

on the pop-up window that appears automatically when you launch the 

Questionnaire Designer. 

 

Alternatively, you can start a new questionnaire by selecting File>New at the 

top of the Questionnaire Designer window. 

 

Before editing your new questionnaire, you must answer the question " Do you 

want to use landscape format for your questionnaire?" by clicking "Yes" or 

"No" in the pop-up window.   The generic STEPS questionnaire is not 

designed in landscape format. 

 
Opening an 

existing 

questionnaire 

To open an existing questionnaire, click on the "Open an existing 

Questionnaire" button on the pop-up window that appears automatically when 

you launch the Questionnaire Designer. 

 

Alternatively, you can open an existing questionnaire by selecting File>Open at 

the top of the Questionnaire Designer window. 

 
Saving a 

questionnaire 
To save a questionnaire, select File>Save at the top of the Questionnaire 

Designer window. 

Continued on next page 
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Introduction, Continued 

 
Questionnaire 

Structure 
An eSTEPS questionnaire is comprised of 3 types of PDA screens: 

 

• Question - contains question text and question fields 

• Text - contains explanatory text 

• Section - contains section heading text and allows you to group related 

question and text screens. 

 

The text and response fields/options for each question in your survey will be 

contained within a Question Screen.  If there is enough room on the PDA 

screen, one Question Screen can contain 2 or more related questions. 

 

The image below shows part of an eSTEPS questionnaire in the Questionnaire 

Designer that uses Sections and has a number of Question and Text Screens.  

 

 
 

 

Section 

Screens 

Text Screen 

Question 

Screens 
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Questionnaire Designer screen components 

 
Introduction This section will familiarize you with the basic components of the 

Questionnaire Designer screen.  There are 4 main parts to the screen, which 

are labeled in the figure below and explained in more detail in the succeeding 

paragraphs. 

 

 

 
Questionnaire 

Overview 
The questionnaire overview comprises the left half of the Questionnaire 

Designer screen.  It shows the overall structure of the current questionnaire.  

The order that Sections, Text, and Question Screens are listed here is how 

they will appear on the PDA. 

 

Beneath this overview are a series of buttons that allow you to modify the 

questionnaire structure and move through the questions in the questionnaire. 

The table below explains the function of each of these buttons in more detail. 

 

Button Function 

Add/Delete Allows you to add or delete a Section, 

Text, or Question Screen from your 

questionnaire.  

Move Up/Move Down Changes the order of your questionnaire by 

moving the selected Section, Text, or 

Question Screen up or down in the order.  

Prev/Next Selects the previous or next Section, Text, 

or Question Screen in your questionnaire so 

you can view it and modify if necessary.  

Continued on next page 

Questionnaire 

Overview 

PDA Preview 

Questionnaire 

Objects 

Object 

Properties 
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Questionnaire Designer screen components, Continued 

 
Questionnaire 

Overview 

(cont.) 

You can modify the level of detail shown in the overview by using the View 

menu at the top of the Questionnaire Designer.  This menu provides the 

following 3 functions: 

 

View Menu Item Function 

Show Fields in Overview Allows you to hide or show question fields in 

the questionnaire overview. 

Expand All Items in 

Overview 

Allows you to expand all sections of the 

questionnaire so all screens are visible in the 

overview. 

Contract All Items in 

Overview 

Allows you to collapse all sections of the 

questionnaire so the minimal number of 

screens is visible in the overview. 

  

 
PDA Preview The majority of the upper right-hand side of the Questionnaire Designer 

shows a preview of what the current Text or Question Screen would look like 

on the questionnaire. 

 

The PDA Preview is modifiable.  You can click on the objects in the preview 

(e.g. text, response fields) to move them around and resize them.  

Additionally you can click on the small keyboard icon in the lower-right hand 

corner of the preview to check if the PDA keyboard (needed for typing in 

numeric and text values) will cover any captions or data entry fields on the 

screen. 

 

For assistance in aligning objects in the preview, a grid of dots can be made 

visible on the PDA Preview by selecting "Show Guides on Items" from the 

View menu at the top of the Questionnaire Designer. 

 
Questionnaire 

Objects 
At the far right-hand side of the Questionnaire Designer screen is a list of 

questionnaire objects that can be added to the current screen of your 

questionnaire.  This list will automatically change depending on the type of 

screen you are currently working on. 

 

For Section and Text Screens, the Questionnaire Objects list simply contains 

Caption and Rich Caption. 

Continued on next page 
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Questionnaire Designer screen components, Continued 

 
Questionnaire 

Objects (cont.) 
For Question screens, the Questionnaire Objects list contains the following: 

• Caption 

• Radio field 

• Text field 

• Numeric field 

• Dropdown field 

• Checkbox field 

• Picture box 

• Signature 

• Rich Caption 

 

How to add these objects to your questionnaire and modify them as needed is 

covered in the following section. 

 
Object 

Properties 
The lower right-hand corner of the Questionnaire Designer contains the 

Object Properties subscreen.  The content of this subscreen shows the 

properties of the currently selected Questionnaire Object.  If no objects are 

selected, this subscreen will show the properties of the currently selected 

Section, Text, or Question Screen. 
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Modifying a new or existing questionnaire 

 
Overview This section provides instructions for a variety of basic tasks to modify a new 

or existing questionnaire.  These tasks include: 

 

• editing the questionnaire title screen 

• creating a new screen 

• editing screen properties 

• creating, editing and deleting captions, images, and question fields 

• saving and exporting your questionnaire. 

 
Editing the 

questionnaire 

title screen 

Follow the steps below to modify the title screen of your questionnaire.  

 

Step Action 

1 Click on the icon next to the very first item listed in the 

Questionnaire Overview.  The properties for the questionnaire 

will then be listed in the Object Properties section of the 

Questionnaire Designer. 

2 Change the name of the questionnaire by typing in the 

"Questionnaire name" field in the Object Properties section. 

3 Change the background color of the title screen by clicking on the 

colored square next to "Background Colour".  A colour palette 

will pop up.  Pick the desired colour and click "Ok."   
 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

Continued on next page 

Step 1 
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Modifying a new or existing questionnaire, Continued 

 
Editing the 

questionnaire 

title screen 

(cont.) 

Step Action 

4 To change the title of the questionnaire, click on the caption in the 

PDA Preview.  You can change the text, font, alignment and text 

color in the Object Properties section. 

 

Note: The buttons on the lower half of the title screen are not modifiable. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Creating a new 

screen 
To add a new Section, Title, or Question Screen to the questionnaire follow 

the steps in the table below. 

 

Step Action 

1 In the Questionnaire Overview, click on the Questionnaire or 

Section Screen to which you wish to add a new screen. 

2 Click the "Add" button in the lower left-hand corner of the screen, 

just below the Questionnaire Overview. 

3 In the "Add New Item" pop-up window, select the type of screen 

you would like to add and click "Ok".  For each type of screen 

this window provides a brief description and an image of a sample 

screen.  

Continued on next page 

Step 2  

Step 3 

Step 4  

Edit text here 
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Modifying a new or existing questionnaire, Continued 

 
Creating a new 

screen (cont.) 

 

 
Editing Screen 

Properties 
After adding a new screen, you can change the properties of the screen (the 

name of the screen shown in the Questionnaire Overview, as well as the 

background colour) by following the steps in the following table.  These 

instructions are similar to those for editing the title screen of the questionnaire 

for which there are accompanying images (see page 11). 

 

Step Action 

1 Click on the icon next to the Section, Text, or Question Screen 

you wish to modify in the Questionnaire Overview.  The 

properties for this screen will then be listed in the Object 

Properties section of the Questionnaire Designer. 

2 Change the name of the screen by typing in the name field in the 

Object Properties section of the screen. 

3 Change the background color of the screen by clicking on the 

colored square next to "Background Colour".  A colour palette 

will pop up.  Pick the desired colour and click "Ok."   

 
Adding and 

Editing a 

Caption 

Captions are text that appear on your PDA screen providing instructions, 

question wording, or the title of the questionnaire or questionnaire section.  A 

"Rich Caption" is the same as a "Caption" with the added feature of having 

multiple display colours and font types within one caption. 
 

Follow the instructions below to add a new caption to your Section, Text, or 

Question Screen and edit a new or existing caption. 

 

Step Action 

1 Click on "Caption" or "Rich Caption" in the list of Questionnaire 

Objects. 

2 In the "Add New Caption" pop-up window, type in the desired 

text in the "Text" field and modify the font as needed by clicking 

on the "Font" button.  When finished making changes, click "Ok". 

3 To edit an existing caption, click on the caption in the PDA 

Preview.  

Continued on next page 

Description 

Select screen type 

Sample screen 
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Modifying a new or existing questionnaire, Continued 

 
Adding and 

Editing a 

Caption (cont.) 

Step Action 

4 After clicking on the caption, you can use the mouse to move and 

resize it.  Additionally, the text and caption properties (e.g. font 

type and size) can be modified in the Object Properties section 

while the caption is selected. 

 

Note: For Rich Captions, the font type and colour can be changed for each 

word or set of words by highlighting the word(s) and modifying the font as 

desired. 

 
Adding and 

Editing an 

Image 

To add an image to a Question Screen, follow the instructions below. 

 

Step Action 

1 Click on "Picture box" in the list of Questionnaire Objects. 

2 In the "Add New Picture box" pop-up window, enter a unique 

Field ID and click on the "Browse" button to locate the desired 

image file. 

3 Adjust the size, border style, and size mode of your picture and 

click the "Preview" button for a preview of the image. 

4 When modifications are complete, click "Ok". 

5 Click on the image in the PDA Preview to move its location or 

resize as needed.  

 
Adding and 

Editing a 

Signature Field 

To add a signature field to a Question Screen, follow the instructions below. 

 

Step Action 

1 Click on "Signature" in the list of Questionnaire Objects. 

2 In the "Add New Signature box" pop-up window, enter a unique 

Field ID, set the desired width and height of the field, and click 

"Ok". 

3 Click on the field in the PDA Preview to move its location or 

resize as needed.  

 
Question Fields The following five Questionnaire Objects are all different types of question 

fields that allow you to store numeric or text responses during data collection.  

Once data collection is complete and data from the PDAs are compiled into a 

final dataset, each field will correspond to one variable in your dataset.  More 

information on each type of field is provided throughout the rest of this 

section.   

 

All of these question fields have a Field ID and Field Length property which 

are described in the following table*.  

Continued on next page 
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Modifying a new or existing questionnaire, Continued 

 
Question Fields 

(cont.) 
Property Description 

Field ID • The ID used to label the variable in your 

questionnaire and in the dataset generated 

during data collection (e.g. C1). 

• Must be unique. 

Field Length • For numeric fields, the number of digits that can 

be entered. 

• For radio or dropdown fields, the maximum 

number of digits that any option can use (e.g. 88 

for a "Refused" option requires 2 digits). 

• For text fields, the size of the text field (text can 

be entered that is longer than the size of field). 

  
*Note: Check box fields are an exception, they do not have a Field Length property. 

 
Adding and 

Editing a Radio 

Field 

A radio field is a type of response field in which several response options are 

listed, each with a small circle next to it.  During data collection, only one 

response option can be selected by clicking on the small circle next to the 

desired response.  

 

Follow the instructions below to add a new radio field to a Question Screen 

and edit a new or existing radio field. 

 

Step Action 

1 Click on the "Radio Field" button in the list of Questionnaire 

Objects. 

2 In the "Add New Radio Answer Field" pop-up window, type in 

the Field ID and Field Length and click "Next". 

3 In the "Edit Answer Options" pop-up window, type in the 

response options.  Use one line per option.  Each line should be 

written in the following order:  

Response value (e.g. 1), comma, Response label (e.g. Male) 

4 Click "Ok" when you have finished typing all the response 

options.  
 

 

 

 

 

 

 

 

 

 

Continued on next page 

Step 2 

Step 3 
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Modifying a new or existing questionnaire, Continued 

 
Adding and 

Editing a Radio 

Field (cont.) 

Step Action 

5 To modify an existing radio field, click on the radio field to make 

its properties appear in the Object Properties section. 

6 You can modify the Field ID and Field Length by editing the 

values of the corresponding fields in the Object Properties section. 

7 To edit the response options, click on "Edit Options" in the Object 

Properties section. 

8 To reposition the radio field on the PDA screen, click on the radio 

field in the PDA preview and use the mouse to drag it to the 

desired location.  
 

 

 

 
Adding and 

Editing a Text 

Field 

A text field allows you to capture text responses, such as the type of "other" 

tobacco smoked. 

 

Follow the instructions below to add a new text field to a Question Screen 

and edit a new or existing text field. 

 

Step Action 

1 Click on the "Text Field" button in the list of Questionnaire 

Objects. 

2 In the "Add New TextField Answer Field" pop-up window, type 

in the Field ID and Field Length and click "Ok". 

3 To modify, resize or reposition the text field, click on the text 

field in the PDA Preview.  Its properties will then appear in the 

Object Properties section of the screen where they can be 

modified as needed.  

Continued on next page 

Steps 5-8 

Click on the radio 

field to select it. 

Edit properties 

here 
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Modifying a new or existing questionnaire, Continued 

 
Adding and 

Editing a 

Numeric Field 

A numeric field allows you to capture numeric responses, such as the number 

of servings of fruit consumed. 
 

Follow the instructions below to add a new numeric field to a Question 

Screen and edit a new or existing text field. 

Step Action 

1 Click on the "Numeric Field" button in the list of Questionnaire 

Objects. 

2 In the "Add New Numeric Answer Field" pop-up window, type in 

the Field ID, Field Length, number of decimal points, and 

minimum and maximum values for the field and click "Ok". 

3 To modify, resize or reposition the numeric field, click on the 

field in the PDA Preview.  Its properties will then appear in the 

Object Properties section of the screen where they can be 

modified as needed.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Adding and 

Editing a 

Dropdown 

Field 

A dropdown field is a type of response field in which several response 

options are listed  in a dropdown list.  During data collection, only one 

response option can be selected from the list by clicking on the field and 

scrolling through the list to the desired response option.  Dropdown fields are 

ideal to use for questions with too many response options to fit easily on the 

PDA screen. 
 

Follow the instructions below to add a new dropdown field to a Question 

Screen and edit a new or existing radio field. 
 

Step Action 

1 Click on the "Dropdown Field" button in the list of Questionnaire 

Objects. 

2 In the "Add New Dropdown Answer Field" pop-up window, type 

in the Field ID and Field Length and click "Next".  

Continued on next page 

Step 2 

Step 3 
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Modifying a new or existing questionnaire, Continued 

 
Adding and 

Editing a 

Dropdown 

Field (cont.) 

Step Action 

3 In the "Edit Answer Options" pop-up window, type in the 

response options.  Use one line per option.  Each line should be 

written in the following order:  

Response value (e.g. 88), comma, Response label (e.g. Refused) 

4 Click "Ok" when you have finished typing all the response 

options. 

5 To modify, resize or reposition the dropdown field, click on the 

field in the PDA Preview.  Its properties will then appear in the 

Object Properties section of the screen where they can be 

modified as needed. 

6 To edit the response options, click on "Edit Options" in the Object 

Properties section.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 
Adding and 

Editing a 

Checkbox Field 

A checkbox field is a type of response field that allows you to indicate 

whether or not a certain condition applies.  In the generic STEPS 

questionnaire, checkbox fields are only used to provide "Don't know" and 

"Refused" options for some questions. 

 

Follow the instructions below to add a new checkbox field to a Question 

Screen and edit a new or existing radio field. 

 

Step Action 

1 Click on the "Checkbox Field" button in the list of Questionnaire 

Objects. 

2 In the "Add New Checkbox Answer Field" pop-up window, type 

in the Field ID and Text (the label that will appear next to the 

check box) and click "Next".  

Continued on next page 

Step 2 

Step 3 
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Modifying a new or existing questionnaire, Continued 

 
Adding and 

Editing a 

Checkbox Field 

(cont.) 

Step Action 

3 To modify, resize or reposition the checkbox field, click on the 

field in the PDA Preview.  Its properties will then appear in the 

Object Properties section of the screen where they can be 

modified as needed.  
 

 

 

 

 

 

 

 

 

 

 
Deleting a 

Caption, Image, 

or Field  

To delete a caption, image or response field from a screen, click on the object 

and click "Delete" on your keyboard or click the "Delete caption/field" at the 

bottom of the Questionnaire Objects list. 

 
Review To summarize some of the tasks explained in this section.  The following 

table provides an overview of the entire process of adding a new Question 

Screen to a questionnaire and placing 3 related response fields on this screen. 

 

Step Action 

1 To add a new Question Screen to the questionnaire, click on the 

icon next to the questionnaire in the Questionnaire Overview and 

click "Add". 

2 Type the name of the Question Screen (this example will 

use"P3ab") and modify the background color if desired. 

3 Click on the caption that automatically appears on a new Question 

Screen and type in the text of the question.  In this example, the 

font size had to be changed to allow all the text to easily fit on the 

screen (see figure next page). 

4 Add a new numeric field to the Question Screen with the Field ID 

of P3a, a Field Length of 2, and min and max values of 0 and 16. 

5 Add another new numeric field to the Question Screen with the 

Field ID of P3b, a Field Length of 2, and min and max values of 0 

and 59. 

6 Add a caption field with the text ":" and place it between the two 

numeric fields.  

Continued on next page 

Step 2 
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Modifying a new or existing questionnaire, Continued 

 
Review (cont.) Step Action 

7 Add two more caption fields: one with the text "hrs" and another 

with the text "mins".  Move "hrs" so that it is located underneath 

the numeric field P3a.  Move "mins" so that it is beneath P3b. 

8 Add a checkbox field with the label "Don't know" and place this 

beneath the "hrs" and "mins" captions. 

9 The Question Screen is now complete.  There are more advanced 

features that can now be added to this group of response fields.  

These more advanced features are discussed in the next section.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3 

Step 5 

Step 8  

(question screen complete) Step 7 
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Advanced Question Editing 

  
Introduction This section will provide a short introduction to the advanced question editing 

features of the Questionnaire Designer.  These features allow you to: 

 

• make the field mandatory or optional; 

• set checks to be run on the field to ensure valid data is entered and, if 

appropriate, jump over non-applicable questions. 

 
Accessing the 

Advanced 

Question 

Editing 

Features 

To access the advanced editing options for a particular field, click on the field 

in the PDA preview and click on the "Edit Checks" button in the Object 

Properties section of the screen. 

 

 

 
Mandatory vs. 

Optional Fields 
The Questionnaire Designer allows you to make any response field 

mandatory or optional.   
 

Mandatory fields must have a response entered before proceeding to the next 

question.  If a response is not entered in a mandatory field, the interviewer 

will not be able to proceed to the next screen of the questionnaire. 
 

Optional fields can be left empty.  In the Questionnaire Designer, there are 

two types of optional fields: 

• Alert user if field is empty (unless hidden), but allow them to proceed 

• Field can be empty. 
 

Both types of optional fields will allow the interviewer to proceed to the next 

screen if the field is blank, but only the 1
st
 type listed above will alert the 

interviewer that the field has been left blank. 

 
Making a field 

mandatory or 

optional 

By default, all fields in the questionnaire are mandatory.  If you wish to make 

a question field optional or make an optional field mandatory again, follow 

the steps in the table below. 

 

Step Action 

1 Click on the question field in the PDA preview and click on the 

"Edit Checks" button in the Object Properties section of the 

screen. 

2 Click on the drop down of the Edit Checks pop-up window and 

select the appropriate option.  

Continued on next page 
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Advanced Question Editing, Continued 

 
Making a field 

mandatory or 

optional 

Step Action 

3 After making your selection, click "OK".  

 

 

 
Field Checks There are 3 types of checks that can be run on a question field.  These are: 

 

• checks evaluated as field is loaded for display 

• checks evaluated immediately on data entry (not available for text or 

numeric fields) 

• checks evaluated when user clicks "Next". 

 

The first type of checks are not used in the generic STEPS questionnaire and 

will not be covered in detail in this manual.   

 

The second type of checks are used in the generic STEPS questionnaire to 

ensure the proper functioning of "Don't know" and "Refused" check boxes.   

 

Finally, the last type of checks are used to ensure that the field has a valid 

response and, if applicable, to jump over non-applicable questions. 

 
Example Check 

Code 
Two examples of check code are provided here with detailed explanations.  In 

these examples, line numbers have been added to the left-hand side of each 

line of code.  These line numbers are not part of the original code but have 

simply been added to aid in the explanation of the code. 

Continued on next page 

Step 2 
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Advanced Question Editing, Continued 

 
Example Check 

Code 1 
This is an example of check code that is run immediately upon data entry.  

This example is taken from the "Don't know" checkbox of question C4 (years 

of education) from the generic STEPS questionnaire.   

 

Check Code: 

1     IF (C4DK=1 AND (C4<>.) AND (C4<>77)) THEN 

2     HELP "You cannot select Don't know and have a value entered." 

3     C4DK=2 

4     ENDIF 

5     IF (C4DK=1 AND C4=.) THEN 

6     C4=@77 

7     EXIT 

8     ENDIF 

9     IF (C4DK=0 AND C4=77) THEN 

10   C4=. 

11   ENDIF 

 

Explanation: 

There are the 3 sections in the above code, each is comprised of one IF 

statement.  In the first section, lines 1 through 4, the code checks to see if the 

user is trying to make the "Don't know" checkbox checked (C4DK=1) when 

there is a value other than 77 for C4.  If this condition is true, it prints the text 

in quotes from line 2 in a pop-up window and unchecks the "Don't know" 

checkbox. 

 

In the next section, lines 5 through 8, the code checks to see if the user is 

trying to make the "Don't know" checkbox checked when C4 is empty.  If this 

condition is true, C4 is set to the "Don't know" value of @77. 

 

In the last section, lines 9 through 11, the code checks to see if the user is 

trying to make the "Don't know" checkbox unchecked (C4DK=0) when C4 is 

77.  If this condition is true, it will clear the C4 field.  

 

Note: The @ sign is used in the check code when setting a field to a value 

outside of its accepted range.  This is required by the eSTEPS PDA software.  

In the above example 77 is outside the accepted range of values for field C4 

and therefore in line 6 C4 is set to "@77" and not simply "77". 

Continued on next page 
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Advanced Question Editing, Continued 

 
Example Check 

Code 2 
This is an example of check code that is run when the interviewer hits "Next".  

This example is taken from the question D1 (number of days fruit consumed) 

from the generic STEPS questionnaire.   

 
Example Check 

Code 2 
Check Code: 

1    IF (D1<>. AND D1<>77 AND D1DK=1) THEN 

2    HELP "You cannot have Don't know selected and have a value entered." 

3    GOTO D1 

4    EXIT 

5   ENDIF 

6   IF (D1=0 OR D1=77) THEN 

7   GOTO D3 

8   ENDIF 

 

Explanation: 

There are the 2 sections in the above code, each is comprised of one IF 

statement.  In the first section, lines 1 through 5, the code checks to see if the 

user has the "Don't know" check box checked (D1DK=1) and has a value in 

D1 other than 77.  If this condition is true, it prints the text in quotes from line 

7 and does not allow the program to proceed to the next screen. 

 

In the 2
nd

 section, lines 6 through 8, the code checks to see if the user has 

entered 0 or 77 ("Don't know") for D1.  If this condition is true, the program 

will jump to question D3 (GOTO D3), effectively skipping question D2. 

 
Further help Writing check code is the most difficult part of designing a questionnaire.  If 

you need assistance or do not feel comfortable writing check code, contact the 

STEPS team (steps@who.int) for help. 
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Exporting your questionnaire 

 
Introduction When you have finished editing your questionnaire, you will need to export it 

to the PDA as well as to an EpiData .qes file.  Both of these tasks can easily 

be accomplished from within the eSTEPS Questionnaire Designer. 

 
Exporting to 

PDA 
To export the questionnaire to the PDA, follow the instructions in the table 

below. 
 

Step Action 

1 Make sure the questionnaire is open in the Questionnaire Designer 

and the PDA is connected and synced to your computer. 

2 Select "Send to PDA" from the File menu at the top of the 

Questionnaire Designer window.  

3 If your PDA is properly synced with your computer, you should 

see "\My Documents\eSTEPS" in the "Select PDA directory" 

window.  This is the default directory on the PDA where the 

questionnaire file is saved.  If you do not see this text, check again 

that your PDA is properly connected and hit the "Connect" button. 

4 Click "Send to PDA".  If the questionnaire has already been 

uploaded before on the same PDA, it will ask if you wish to 

overwrite it.  Click "OK" if you wish to overwrite the version 

already on the PDA. 

5 If the transfer is successful, you will get the following message in 

a pop-up window: "Questionnaire successfully transferred to the 

PDA."  Click "OK" on this window and then click "Close" on the 

"Select PDA directory" window. 
 

Note: The eSTEPS Manager, which is covered in detail in the next section, 

can also be used to upload the questionnaire to the PDA. 

 

Exporting to 

EpiData .qes 

file 

The questionnaire must be exported to an EpiData .qes file before any records 

can be downloaded from the PDA.  Therefore this step need only be 

completed once you are ready to download data from the PDA(s). 
  

To export the questionnaire to a .qes file, follow the instructions in the table 

below. 
 

Step Action 

1 Make sure the questionnaire is open in the Questionnaire 

Designer. 

2 Select "To EpiData .qes file …" from the Export menu at the top 

of the Questionnaire Designer window.  

3 Locate the folder on your computer in which you wish to save the 

.qes file and click "OK".  If the creation was successful you will 

receive a message saying "Export successful to file: [file name]".  

Click "OK" to finish.  
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Part 3: eSTEPS Manager 

Overview 

 
Introduction The eSTEPS Manager enables you to perform basic file management tasks 

including: 

• uploading/downloading questionnaires to/from PDA 

• renaming and deleting questionnaires on the PDA 

• downloading record files from the PDA to the computer 

• downloading Kish Method data to the computer 

• managing records files on the computer. 

 
Opening the 

eSTEPS 

Manager 

To open the eSTEPS Manager, click on your Start menu and select 

eSTEPS>eSTEPS Manager from your list of Programs. 

 

 
 

 
Exiting the 

eSTEPS 

Manager 

To exit the eSTEPS Manager, simply click on the close button in the upper 

right-hand corner of the window. 
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Managing Questionnaires 

 
Introduction Questionnaire (.qml) files can be uploaded to the PDA, deleted from the PDA, 

and renamed on the PDA by using features in the "Manage Questionnaires" tab 

in the eSTEPS Manager. 

 

It is important to note that, in order to be used by the eSTEPS PDA software, a 

questionnaire (.qml file) must be named "eSTEPS". 

 
Adding a 

Questionnaire 

to the PDA 

To add a questionnaire to the PDA, follow the steps in the table below. 

 

Step Action 

1 Click on the "Manage Questionnaires" tab in the eSTEPS 

Manager. 

2 Make sure the PDA is connected and synced to your computer. 

3 The location of the questionnaire(s) on the PDA should 

automatically appear in the upper field on the eSTEPS Manager 

screen.  If it does not appear, double-check the connection 

between your PDA and computer and click the "Connect" button. 

4 Click on the button "Add Questionnaire(s) to PDA". 

5 Locate the questionnaire you wish to add to the PDA and click 

"Open" in the pop-up window.  If you already have a 

questionnaire on the PDA with the same name, a pop-up window 

will appear asking if you wish to overwrite the questionnaire on 

the PDA.  Click "OK" to continue. 

6 The uploading may take a few seconds.  Once it is complete, the 

questionnaire should be listed in the list of files on the eSTEPS 

Manager screen. 

  

 

 

Continued on next page 

Step 3 
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Managing Questionnaires, Continued 

 
Adding a 

Questionnaire 

to the PDA 

(cont.) 

 

 
Deleting a 

Questionnaire 

from the PDA 

To delete a questionnaire from the PDA, follow the steps in the table below. 
 

Step Action 

1 Click on the "Manage Questionnaires" tab in the eSTEPS 

Manager. 

2 Make sure the PDA is connected and synced to your computer. 

3 The location of the questionnaire(s) on the PDA should 

automatically appear in the upper field on the eSTEPS Manager 

screen.  If it does not appear, double-check the connection 

between your PDA and computer and click the "Connect to PDA" 

button. 

4 All the questionnaire (.qml) files that are on the PDA should be 

listed in the list of files in the eSTEPS Manager screen.  Select the 

questionnaire file you wish to delete by clicking on it once. 

5 Click on the button "Delete Questionnaire" to delete the selected 

questionnaire.  Once it is deleted, the questionnaire should no 

longer be listed in the list of files.  

 
Renaming a 

Questionnaire 

on the PDA 

To rename a questionnaire on the PDA, follow the steps in the table below. 
 

Step Action 

1 Click on the "Manage Questionnaires" tab in the eSTEPS 

Manager. 

2 Make sure the PDA is connected and synced to your computer. 

3 The location of the questionnaire(s) on the PDA should 

automatically appear in the first field on the eSTEPS Manager 

screen.  If it does not appear, double-check the connection between 

your PDA and computer and click the "Connect to PDA" button.  

Continued on next page 

Step 6 
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Managing Questionnaires, Continued 

 
Renaming a 

Questionnaire 

on the PDA 

(cont.) 

Step Action 

4 All the questionnaire (.qml) files that are on the PDA should be 

listed in the list of files in the eSTEPS Manager screen.  Select the 

questionnaire file you wish to rename by clicking on it once. 

5 Click on the button "Rename Questionnaire" to make the name of 

the questionnaire modifiable.  Type the new name of the 

questionnaire and then click in the white space on the eSTEPS 

Manager screen to finish.  

 
Downloading a 

questionnaire 

from the PDA 

to the computer 

You may need to download a questionnaire file from the PDA onto your 

computer if the questionnaire file was created on a different computer.  

Downloading the questionnaire file to your computer does not copy any 

records onto your computer.  See the next section to learn how to download 

records from the PDA to the computer. 

 

To download a questionnaire from the PDA, follow the steps in the table 

below. 

 

Step Action 

1 Click on the "Manage Questionnaires" tab in the eSTEPS 

Manager. 

2 Make sure the PDA is connected and synced to your computer. 

3 The location of the questionnaire(s) on the PDA should 

automatically appear in the first field on the eSTEPS Manager 

screen.  If it does not appear, double-check the connection 

between your PDA and computer and click the "Connect to PDA" 

button. 

4 All the questionnaire (.qml) files that are on the PDA should be 

listed in the list of files in the eSTEPS Manager screen.  Select the 

questionnaire file you wish to copy by clicking on it once. 

5 Click on the button "Copy questionnaire file to this computer" and 

then locate the folder on your computer where you wish to save it.  

Click "Save" once you have located where you wish to save the 

questionnaire file on your computer.  
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Managing PDA Records 

 
Introduction Records (.rml) files can be downloaded from the PDA, deleted from the PDA, 

and renamed on the PDA by using features in the "Manage PDA Records" tab 

in the eSTEPS Manager.  Additionally, the information from the Kish Method 

can be downloaded from the PDA to your computer using the eSTEPS 

Manager. 
 

Both the records file and Kish Method data file are automatically generated 

during data collection on the PDA.  These files will have the same name as 

the corresponding questionnaire file.  Thus, since your questionnaire file is 

called "eSTEPS.qml", the records file will be called "eSTEPS.rml" and the 

Kish Method data will be called "eSTEPS.kish". 

 

Preparing for 

exporting 

records from 

the PDA 

Before exporting records from the PDA, you must create a .rec file for your 

questionnaire using the software program EpiData.  The data stored in the 

eSTEPS records (.rml) file will be saved into the .rec file on your computer.  

From this .rec file, you can then export the data to a wide variety of formats 

for data analysis. 
 

The .rec file can be easily generated from an EpiData .qes file.  Upon 

completing the editing of your questionnaire in the Questionnaire Designer, 

you can generate the .qes file for your questionnaire by following the 

instructions on page 25 of this manual. 
 

To generate the .rec file from the .qes file, follow the instructions in the table 

below.  
 

Step Action 

1 Ensure that the EpiData settings are correct: Go to File > Options 

in the upper left-hand corner of the EpiData screen.  Select the 

"Create data file" tab Options pop-up window.  Make sure that 

"First word in question is field name" and "Upper-case" are 

selected. 

2 Click on the button "2. Make Data File" at the top of the screen. 

3 Find the .qes file of your questionnaire (created using the 

Questionnaire Designer) so that it appears in the first field in the 

pop-up window.  Type in the location and name of the .rec file in 

the 2
nd

 field in the pop-up window.  (e.g. for a .qes file called 

"eSTEPS.qes" you can type the name "eSTEPS.rec" for the .rec 

file)  

4 Click "OK" and close EpiData.  

 

Exporting 

records from 

the PDA 

To export records from the PDA, follow the steps in the table below. 
 

Step Action 

1 Click on the "Manage PDA Records" tab in the eSTEPS Manager. 

2 Make sure the PDA is connected and synced to your computer.  

Continued on next page 
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Managing PDA Records, Continued 

 
Exporting 

records from 

the PDA (cont.) 

Step Action 

3 The location of the records (.rml) file on the PDA should 

automatically appear in the upper field on the eSTEPS Manager 

screen.  If it does not appear, double-check the connection 

between your PDA and computer and click the "Connect to PDA" 

button. 

4 The records file (.qml) and Kish Method data file (.kish) that are 

on the PDA should be listed in the list of files in the eSTEPS 

Manager screen.  Select the records file by clicking on it once. 

5 Click on the button "Export records to EpiData .REC file" to 

download the records from the PDA into the EpiData .rec file.  If 

there are any unfinished records in the records file, a pop-up 

window will appear asking if you would like to include these 

records or not.  Click "Yes" or "No" to continue.   

6 Once the process has successfully completed, a pop-up window 

will appear stating "Records successfully exported."  Click "OK".  

Finally, you will be asked if you wish to delete the records from 

the PDA.  Click "Yes" or "No" to finish.  

 
Exporting Kish 

Method data 

from the PDA 

To export Kish Method data from the PDA, follow the steps in the table 

below. 

Step Action 

1 Click on the "Manage PDA Records" tab in the eSTEPS Manager. 

2 Make sure the PDA is connected and synced to your computer. 

3 The location of the Kish Method data file (.kish) on the PDA 

should automatically appear in the upper field on the eSTEPS 

Manager screen.  If it does not appear, double-check the 

connection between your PDA and computer and click the 

"Connect to PDA" button. 

4 The records file (.qml) and Kish Method data file (.kish) that are 

on the PDA should be listed in the list of files in the eSTEPS 

Manager screen.  Select the Kish Method data file by clicking on it 

once. 

5 Click on the button "Export .kish to .csv" to download the Kish 

Method data from the PDA to a .csv file (comma-delimited file).  

Select the location you wish to save the .csv file and click "Save".  

The file will automatically receive the same name as your 

questionnaire (e.g. eSTEPS.csv if your questionnaire was named 

eSTEPS.qml).  

6 A pop-up window should appear informing you that the export 

was successful.  Click "OK" to finish.  

Continued on next page 
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Managing PDA Records, Continued 

 
Renaming or 

deleting records 

files on the 

PDA 

To rename or delete a records file or Kish Method data file on the PDA, follow 

the steps in the table below. 

 

Step Action 

1 Click on the "Manage PDA Records" tab in the eSTEPS Manager. 

2 Make sure the PDA is connected and synced to your computer. 

3 The location of the records and Kish Method data files on the PDA 

should automatically appear in the upper field on the eSTEPS 

Manager screen.  If it does not appear, double-check the connection 

between your PDA and computer and click the "Connect to PDA" 

button. 

4 The records file (.qml) and Kish Method data file (.kish) that are on 

the PDA should be listed in the list of files in the eSTEPS Manager 

screen.  Select the file you wish to rename or delete by clicking on 

it once. 

5 To delete a file, click on the "Delete" button.  To rename a file, 

click on the "Rename" button.  
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Additional Functions of the eSTEPS Manager 

 
Introduction There are some additional functions available in the eSTEPS Manager that 

will be covered in full detail in this manual.  This section will just provide an 

overview of these functions.  Please contact the STEPS team for further help 

with any of these functions (steps@who.int). 

 
Exporting 

Local Records 
While it is recommended to use the eSTEPS Manager to export from the .rml 

file on your PDA directly to the EpiData .rec file on your computer, the 

capability exists to save the .rml file on the PDA to an encrypted .rml file 

(.encrml) on your computer and then move the data from the encrypted .rml 

file to the .rec file.  Use the "Export Local Records" tab of the eSTEPS 

Manager to perform this function. 

 
Importing 

records from 

EpiData 

The eSTEPS Manager also allows you to export data from an EpiData .rec 

file into an eSTEPS records file.  You will need to have the original eSTEPS 

questionnaire file (.qml) with which the data in the .rec file was collected.  If 

the .qml file and .rec file do not have identical fields, the data import will not 

work.  Use the "Import from EpiData" tab of the eSTEPS Manager to perform 

this function. 
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Part 4: eSTEPS PDA Software 

Overview 

 
Introduction The eSTEPS PDA Software is used during the actual collection of data.  It 

enables the data collectors to perform the Kish Method in the field and 

provides the text and response fields for the interview. 

 
Opening the 

eSTEPS PDA 

Software 

Before opening the eSTEPS PDA Software, you should already have your 

questionnaire file (.qml) uploaded to the PDA. 

 

To open the eSTEPS PDA Software, select eSTEPS from the Start menu on 

the PDA. 

 

 
Settings Before beginning any data collection, there are a variety of settings that 

should be checked and adjusted as needed.  These can be found in the 

"Options" menu in the lower-left hand corner of the eSTEPS home screen. 

 

 

Continued on next page 
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Overview, Continued 

 
Setting the 

Autosave 

Function 

eSTEPS will automatically save the current record to the PDA every set 

number of minutes.  The default is 2 minutes.  It is not recommended to 

modify this option, but it can be modified by selecting "Set Autosave" from 

the "Options" menu. 

 
Setting Device 

Properties 
Each PDA should receive a unique Device ID.  This can be set by selecting 

"Set Device Properties" from the "Options" menu. 

 
Setting Kish 

Properties 
The minimum and maximum age allowable for an eligible household member 

can be set by selecting "Set Kish Properties" from the "Options" menu.  When 

using the Kish Method to select the participant from a household, the program 

will not allow the user to enter a person outside of this age range. 

 
Language 

Setting 
The other languages in which eSTEPS is currently available can be selected 

from the "Set Language" drop down list in the "Options" menu.  The change 

of language will take effect immediately.   

 

Please note that this language change will only effect the text of the eSTEPS 

PDA software, not the text of the questionnaire itself.  If you wish to have a 

questionnaire in your local language, it must be built in your local language 

using the eSTEPS Questionnaire Designer. 

 
Exiting eSTEPS To exit from eSTEPS, go to File > Exit eSTEPS in the lower left-hand corner 

of the eSTEPS home screen.  A password is required to exit the program in 

order to prevent the use of the PDA for purposes other than eSTEPS.  Please 

contact the STEPS team (steps@who.int) for the password. 
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The Kish Method 

 
Introduction The Kish Method is a technique that allows for the random selection of one 

individual from a household.  For more information about the Kish Method, 

see Part 2, Section 2 of the STEPS Manual.  The paper-based version, on 

which the eSTEPS PDA version is based, is provided there. 

 

The Kish Method should be performed once for each household upon making 

first contact with a household member.  There are 3 parts to the Kish Method: 

1. Enter Household ID. 

2. Enter all eligible household members and select one using the Kish 

Method. 

3. Enter Participant ID for selected household member. 

 
Accessing the 

Kish Method 
Click on the "Kish" button in the lower left-hand part of the screen to start the 

Kish Method for a given household. 

 

 

 
Part 1: Add a 

new Household 
On the first screen of the Kish Method, the Household ID must be entered the 

selected Household before continuing onto the next part of the process.  

Follow the instructions below to complete this part of the Kish Method 

process. 

 

Step Action 

1 Click in the field at the top of the screen labeled "HhID." and use 

the PDA's keyboard to fill in the Household ID (maximum of 12 

digits).  When finished typing in the number click the "Add" 

button in the top right-hand corner of the screen. 

2 The Household ID just entered should now be listed in the box 

below along with the number 0, indicating 0 eligible members 

have been entered for this household. 

3 Click on the Household ID you have just entered as it appears in 

the list and click on the "Select" button at the bottom left-hand 

corner of the screen to proceed to the next stage of the process.  

Continued on next page 
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The Kish Method, Continued 

 
Part 1: Add a 

new Household, 

cont. 

 

 

 

  

 
Part 2: Enter 

Household 

Members and 

Select 

Participant 

On the next screen you will see the HhID at the top of the screen.  You may 

modify it if needed by clicking on the "Edit" button next to the HhID field. 

 

To complete the list of eligible household members for this household, follow 

the steps below. 

 

Step Action 

1 Click on the "Add" button in the lower half of the screen. 

2 On the "Add new household member" screen, complete the name 

and age of the participant using the PDA keyboard and select the 

sex of this person by clicking on the round circle next to "Male" 

or "Female".  When you have finished entering this information 

for one household member, click on the "Add" button to return to 

the previous screen. 

3 To add another person to the list of household members, click on 

"Add" again and repeat Step 2. 

  

 

 

 

 

 

 

 

 

 

 

 

Continued on next page 

Step 1: Type in HhID and 

click "Add". 
Step 3: Select Hh in list 

and click "Select". 

Step 2: Complete Name, Age, and Sex of household member and click "Add". 
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The Kish Method, Continued 

 
Part 2: Enter 

Household 

Members and 

Select 

Participant, 

cont. 

Step Action 

4 If the information for any members of the household needs to be 

modified, select that household member in the list and click 

"Edit".  If any members need to be removed from the list, select 

the household member in the list and click "Delete". 

 

Once all household members have been entered, click on the "Calculate" 

button to apply the Kish Method.  The selected household member will 

appear in the field at the bottom of the screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click on the "Next" button to continue to the final part. 

 
Part 3: Enter 

PID and Exit 

Kish 

In the final screen of the Kish Method, you must enter the Participant ID 

(PID) for the selected person.  The PID should be entered immediately, 

regardless of whether the interview will take place immediately or at a later 

time. 

 

Use the PDA keyboard to enter the PID, then click "Done". 

 

 
 

Continued on next page 

Selected person 

is listed here. 

Complete PID here: 
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The Kish Method, Continued 

 
Part 3: Enter 

PID and Exit 

Kish, cont. 

After clicking "Done" you will be asked whether or not you would like to 

conduct the interview immediately or not.  If you wish to do the interview at 

the present time, click "Yes", otherwise click "No". 

 

 
 

By clicking "No", a record is automatically generated for this interview.  

When you are ready to conduct this interview at a later time, you will need to 

search and find this record on the PDA (see instructions on p. 40).  You will 

NOT need to return to the Kish Method for this household again. 
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Records Management on the PDA 

 
Introduction Within the eSTEPS PDA software, one can create new records, open existing 

records, and obtain a summary of all records currently on the PDA.  Each of 

these functions corresponds to one of the buttons on the eSTEPS home 

screen. 

 
Starting a new 

record 
To start a new record, click on the "Start New Record" button on the eSTEPS 

home screen. 

 

Note: It is recommended you create new records using the Kish Method.  The 

last part of the Kish Method process asks for the Participant ID of the selected 

person and automatically generates a record for this person. 

 
Opening an 

existing record 
To  open an existing record, follow the instructions in the table below. 

 

Step Action 

1 Click on the "Open Existing Record" button on the eSTEPS home 

screen. 

2 Select the fields by which you would like to see all records listed.  

There is the possibility to pick 2 different fields.  It is 

recommended to select Participant ID (PID) as the first of these 

fields. 

3 Find the record you wish to open in the list of all records and click 

"Open" at the bottom of the screen. 

 

 
 

Note: In the event that a record is created unintentionally, the record can be 

deleted by holding the PDA stylus for a few seconds on the unwanted record 

in this list.  You will then have a pop-up "Delete" button appear which you 

can click on to delete the unwanted record. 

Continued on next page 

Select 2 fields to show for each record 

Select the record you wish to  open from 

the list. 
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Records Management on the PDA, Continued 

 
Viewing a 

summary of 

records 

Click on the "Summary" button on the eSTEPS home screen to view a 

summary of all the records on the PDA.  The summary will indicate the total 

number of finished and unfinished records on the PDA. 

 

 
Saving a 

backup copy of 

the survey data 

It is possible to save a back-up copy of all survey data to an SD external 

memory card at any time.  An example of an SD external memory card is 

shown below. 

 

To save a back-up copy of all survey data to a memory card, follow the 

instructions in the table below. 

Step Action 

1 Insert the SD card into the slot on the PDA. 

2 On the eSTEPS home screen, select "Backup to Memory Card" 

from the File menu in the lower left-hand corner of the screen. 

3 Tap "Yes" in the pop-up window asking if you would like to save 

a back-up copy to a memory card. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Example of SD 

memory card 

Step 2 



eSTEPS User Manual 

WHO STEPS Surveillance 

42 

Entering Interview Data 

 
Introduction The section will review the variety of tasks the interviewer will need to 

perform during the course of an interview using the eSTEPS PDA software.  

These tasks include: 

 

• moving from one question to another 

• entering data in all types of data fields (e.g. text fields, radio buttons) 

• exiting the questionnaire 

• resuming an interrupted interview. 

 
Previous/Next 

buttons 
The "Previous" and "Next" buttons are located at the bottom of the 

questionnaire screen.  These buttons allow you to move to the next or 

previous screen in your questionnaire. 
 

"Previous" should be used rarely and only when it is necessary to return to a 

previously answered question if the participant requests to change their 

response. 
 

"Next" should be used after completing the mandatory questions on each 

screen.  If you tap "Next" before completing all mandatory questions on the 

current screen, you will receive a warning in a pop-up window and the 

questionnaire will not proceed to the next question. 

 
PDA keyboard The PDA keyboard will be needed to enter data in text fields.  If the keyboard 

does not appear automatically when you select the field with the PDA stylus, 

you can make it appear by tapping on the keyboard icon in the bottom right-

hand corner of the screen (see image below). 

 

 

 

 

 

 

 

 

 

 

 

 

 
Entering data 

in a text field 
To enter data in a text field, tap on the text field with the PDA stylus.  Type 

the text you wish to write using the PDA keyboard (tap on each letter with the 

stylus; capital letters can be made using the Shift and CAP keys, just as on a 

normal keyboard).  If needed, the delete key is the black arrow in the upper 

right-hand corner of the keyboard. 

Continued on next page 
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Entering Interview Data, Continued 

 
Entering data 

in a numeric 

field 

To enter data in a numeric field, you can do one of the following: 

• use the arrows at the right-hand side of the field to scroll up or down to the 

desired figure; 

• use the number pad to type in the desired number (the number pad will 

automatically appear when you select the number field); 

• use the number keys on the PDA keyboard to type in the desired number. 

 

 

 

 

 

 

 

 

 

  

 

 
Clearing data 

in a numeric or 

text field 

To erase all or part of a value in a text or numeric field, use the back arrow 

key at the upper right-hand corner of either the PDA keyboard or Number 

pad. 

 
Entering data 

in a radio field 
To enter data in a radio button field, simply tap on the small circle next to the 

chosen response option.  If another option is picked, the first option will 

automatically be deselected as only one option can be picked at a time for a 

given question. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Continued on next page 

Arrows 

 

Number pad 

 

PDA keyboard 

 

Tap once on the circle 

next to the desired 

response option. 
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Entering Interview Data, Continued 

 
Entering data 

in a dropdown 

field 

To select an item in a dropdown field, tap once on the small down arrow at 

the right-hand side of the field.  The list of options will then appear.  After 

reading the options to the participant, tap once on the option to select it. 

 

 

 

 

 

 

 

 

 

 

 

 
Entering data 

in a checkbox 

field 

Checkbox fields are used in eSTEPS for Don't know and Refused responses.  

These may only be selected if the associated data field is blank, eSTEPS will 

not let you proceed if you have entered a valid response and also selected 

Don't know or Refused.   

 

To select Don't know or Refused, simply tap on the square next to the desired 

response.  Tap on the square again to unselect Don't know or Refused. 

 

For most questions with Don't know and Refused checkbox fields, checking 

on one of these options will automatically fill in the associated data field with 

the Don't know (77) or Refused (88) values, as in the example below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Continued on next page 

Tap once on the 

square next to the 

response option. 
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Entering Interview Data, Continued 

 
Exiting a 

completed 

questionnaire 

When you reach the end of the questionnaire, the eSTEPS PDA software will 

show the final screen of the questionnaire, which reads "End of Interview".  

Tap on the "Finish" button at the bottom of the screen to finish the record and 

close the questionnaire.  Before returning to the eSTEPS home screen, you 

will be asked if you would like to save a backup copy to a storage card.  Click 

"Yes" only if you currently have a storage card inserted in your PDA. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Exiting an 

unfinished 

questionnaire 

If you must end an interview before reaching the end of the questionnaire, 

either because the participant no longer wishes to participate or because the 

interview must be temporarily stopped (and resumed at a later time), select 

"Close Questionnaire" from the File menu at the bottom left-hand corner of 

the screen. 

 
 

Upon closing the current record, the record will be automatically saved and 

eSTEPS will return to the eSTEPS home screen. 

 

Note: If at all possible, it is recommended that you finish the current section 

(e.g. Diet) before stopping an interview you plan to resume at a later time. 

Continued on next page 
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Entering Interview Data, Continued 

 
Resuming an 

interrupted 

interview 

To resume an interview that has been interrupted, follow the instructions in 

the table below. 

 

Step Action 

1 On the eSTEPS home screen, click on the "Open Existing 

Record" button. 

2 At the top of the next screen, select the two variables by which 

you wish to search.  It is recommended that you use Participant ID 

(PID) as your first variable. 

3 In the list of records, search and find the record that corresponds 

to the person whose interview you would like to resume.  Tap on 

this record to select it and tap "Open" at the bottom of the screen. 

4 Once the record opens, it will automatically bring you to the first 

screen of the questionnaire.  To move to the point in the 

questionnaire at which the interview was interrupted, you can  

either continually tap "Next" until you reach the interruption point 

or jump directly to the interruption point by following the steps 

below: 

 

Step Action 

4.1 Tap "Select Item" from the Go menu at the 

bottom of the screen.  

4.2 Search and find the next question to be 

answered in the interview.  Tap on that 

question to select it and then tap "Go". 

 

 

 

 

 

 

 

 

 

 

 

 

   

 

 

 

 

Continued on next page 

Select fields 

Select record 

Step 1 Step 2 and 3 
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Entering Interview Data, Continued 

 
Resuming an 

interrupted 

interview, cont. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4.1 Step 4.2 



eSTEPS User Manual 

WHO STEPS Surveillance 

48 

Part 5: Creating the Final Dataset 

Overview 

 
Introduction Once data collection has been completed, one person should oversee the task of 

creating the final dataset.  This task may be completed by the data analyst, but 

he/she may need assistance from the Survey Coordinator or Data Collection 

Supervisors to coordinate obtaining the data files from the PDAs used for data 

collection. 

 
Process The task of creating the final dataset entails the following steps: 

 

Step Action 

1 Copy the records files from each PDA onto one computer. 

2 Export the dataset from EpiData and import it into Microsoft 

Access. 

3 Attach the Epi Info analysis programs. 

4 Append the Kish Method data to the dataset. 

 

Note: The instructions provided here assume that analysis will be done in Epi 

Info using the Epi Info analysis programs provided by the STEPS team.  If you 

wish to complete your analysis using a different statistical software package, 

please contact the STEPS team for further assistance (steps@who.int). 
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Appending all records 

 
Introduction The records stored on each PDA can be appended together simply by saving 

each one consecutively into the EpiData .rec file on one computer.  However, 

it is recommended that the data from each PDA also be saved in a separate 

file (one per PDA) as a backup in case there are any problems/questions later 

on during the data management/analysis work. 

 
EpiData .rec 

file 
Before any data can be copied from the PDAs to the computer, you must have 

a copy of the EpiData .rec file that corresponds to your questionnaire.  All the 

records on each PDA will be copied into this one EpiData .rec file. 

 

The original eSTEPS questionnaire (.qml) file for your site can be used to 

create an EpiData questionnaire (.qes) file in the eSTEPS Questionnaire 

Designer.  Within EpiData, the .qes file can then be converted to an EpiData 

records (.rec) file.  Step-by-step instructions of these two processes are 

provided on pages 25 and 30 . 

 
Make copies of 

the .rec file 
In addition to the .rec file that will contain all the PDA data, you should make 

a copies of this .rec file (1 per PDA) and rename them accordingly: 

PDA1.rec, PDA2. rec, etc. 

 

Thus, you will have one master .rec file (e.g. MasterDataSet.rec) and one 

several individual PDA .rec files (PDA1.rec, PDA2.rec, etc.), all of which are 

blank at this stage. 

 
Copying data to 

your computer 
Follow the steps below to create your final dataset. 

 

Step Action 

1 Organize and label all PDAs to ensure there will be no possibility 

of accidentally copying the data off the PDA twice. 

2 Open the eSTEPS Manager program and click on the "Manage 

PDA Records" tab. 

3 Connect the PDA to your computer.  Make sure it is properly 

connected and synced to your computer. 

4 If the records (.rml) file on the PDA does not automatically 

appear, double-check the connection between your PDA and 

computer and click the "Connect to PDA" button. 

5 Select the records file by clicking on it once. 

  

Continued on next page 
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Appending all records, Continued 

 
Copying data to 

your computer, 

cont. 

 

Step Action 

6 Click on the button "Export records to EpiData .REC file" to 

export the records from the PDA into the master EpiData .rec file.  

If there are any unfinished records in the records file, a pop-up 

window will appear asking if you would like to include these 

records or not.  Click "Yes" to continue. 

7 Once the process has successfully completed, a pop-up window 

will appear stating "Records successfully exported."  Click "OK".  

Finally, you will be asked if you wish to delete the records from 

the PDA.  Click "No." 

8 Repeat steps 5-7 for the same PDA but save to the individual 

PDA's .rec file instead. 

9 Repeat steps 3-8 for each PDA, being very careful not to 

download the data from the same PDA more than once. 

  

 
Checking the 

total number of 

records 

Once you have finished saving the data from all the PDAs into the EpiData 

.rec file, you should compare the total number of records in this file to the 

total number of records across all the individual PDA .rec files.  If the two 

numbers do not match, you should delete the master .rec file and redo the 

entire process. 

 

To check the total number of records of your EpiData .rec file, double-click 

on the file to open it.  If it does not automatically open in EpiData, open 

EpiData and click on "4. Enter Data" at the top of the screen and locate and 

open your .rec file. 

 

Once your .rec file is open, the total number of records will be shown in the 

small box at the bottom left-hand corner of the screen in between the small 

black arrows.  The text in this box will read "New/xxxx" where xxxx is the 

total number of records in your file. 
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Exporting from EpiData 

 
Introduction After appending all records into one file within EpiData, you will then need to 

export the data from EpiData so that it can be analyzed in Epi Info or other 

statistical program of your choice. 

 
Export the 

dataset for 

analysis 

The first step in preparing your data for analysis in Epi Info is to export it 

from EpiData into an Excel file (.xls).  Follow the steps below to export the 

dataset. 

 

Step Action 

1 Open EpiData.  

2 Click on "6. Export Data". 

3 Select "Excel" from the list. 

4 Select MasterDataSet.rec as the file to open. 

5 In the "Export data file to Excel file" window simply click "OK".  

Do not change anything in the popup window. 

6 Your data is now in the MasterDataSet.xls file in the same location 

as your MasterDataSet.rec file.  The Excel file will need to be 

updated to a more recent version.  To do so, simply open the file, 

save it, and close it.  You will automatically be prompted to save it 

in a newer version.  

 

Instructions for 

importing data 

from EpiData 

The next step is to transform the Excel file into a Microsoft Access database 

file.  To use the automated Epi Info analysis programs available from the 

STEPS team, the data must be named and located precisely as described here 

in order for these programs to work properly.  The table below describes how 

to transform your data from the .dbf file to the Access database file. 

 

Step Action 

1 Create a new Microsoft Access file and rename it "STEPS.mdb." 

(To create a new Access file, right click anywhere in the folder and 

select New > "Microsoft Office Access Application".) 

2 Open the STEPS.mdb file and go to File>Get External 

Data>Import. 

3 Change the file type to .xls and select your MasterDataSet.xls file 

and click "Import". 

4 In the first popup window that follows, select "First Row Contains 

Column Headings".  Then click "Next". 

5 Click "Next" on the next two screens of the popup window. 

6 On the 4
th

 screen of the popup, select "No primary key", then click 

"Next". 

7 On the 5th screen of the popup, click "Finish" and click "OK" on 

the confirmation popup.  

Continued on next page 
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Exporting from EpiData, Continued 

 
Instructions for 

importing data 

from EpiData, 

cont. 

Step Action 

8 You will now see the data table "MasterDataSet" listed in your 

Database window.  You may open it to have a look at your data. 

9 Exit from Access.   

10 If you have not already done so, create a folder "STEPS" on the C 

drive of your computer.  Within this folder make another folder 

called "Epi Info". 

11 Move the STEPS.mdb file to the C:\STEPS\Epi Info folder.  

 
Epi Info 

analysis 

programs  

The data analysis programs are available on the STEPS CD as well as on the 

STEPS website.  As these are occasionally updated to meet country needs, it 

is best to check the updates page on the STEPS website 

(http://www.who.int/chp/steps/resources/updates/en/index.html) to see if a 

more recent version is available. 

 

The following table describes how to download the Epi Info analysis 

programs from the internet and attach them to your STEPS.mdb file 

containing your survey data. 

 

Step Action 

1 Connect to the internet and go to: 

http://www.who.int/chp/steps/resources/ 

database/en/index.html 

2 Click on the link labeled " Epi Info Analysis Programs". 

3 Save the zip file, "Epi_Info_Analysis_Programs.zip", to your 

desktop.   

4 Open the zip file by double-clicking on it.  Copy the Access file, 

Epi_Info_Analysis_Programs.mdb, to your desktop. 

5 Open the Epi_Info_Analysis_Programs.mdb file and right click on 

the table "Programs". 

6 Select "Export" and in the "Select Table to Export to" window 

select STEPS.mdb (this should be located in your C:\STEPS\Epi 

Info folder).  

7 Select the "Definition and Data" option in the dialogue window 

and click "OK".  If you are replacing an older version of the 

programs, a dialogue window will appear asking if you want to 

replace the old "Programs" table.  Click "Yes".  
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Appending Kish Method Data 

 
Introduction The Kish Method data stored on each PDA needs to be saved onto one 

computer, appended together, and attached to the dataset. 

 
Preparation Before copying the Kish Method data files from all the PDAs onto your 

computer, it is important to first create the correct folder in which to save 

them.  If you have not already done so, create the folder: 

 

C:\STEPS\data\Kish data 

 

The Kish Method data files must be saved in this exact location in order for 

the automated programs to work correctly. 

 
Copying the 

Kish Method 

data files to 

your computer 

The table below provides instructions on how to copy all the Kish Method 

data files to your computer.  Since each of these files will automatically be 

named the same on each PDA, it is critical that you modify the name of each 

one as you save it to your computer.  For example: 

eSTEPS1.csv, eSTEPS2.csv, eSTEPS3.csv, etc. 

 

Step Action 

1 Organize and label all PDAs to ensure there will be no possibility 

of accidentally copying the data off the PDA twice. 

2 Open the eSTEPS Manager program and click on the "Manage 

PDA Records" tab. 

3 Connect the first PDA to your computer.  Make sure it is properly 

connected and synced to your computer. 

4 The location of the Kish Method data file (.kish) on the PDA 

should automatically appear in the first field on the eSTEPS 

Manager screen.  If it does not appear, double-check the 

connection between your PDA and computer and click the 

"Connect to PDA" button. 

5 The records file (.qml) and Kish Method data file (.kish) that are 

on the PDA should be listed in the list of files in the eSTEPS 

Manager screen.  Select the Kish Methods data file by clicking on 

it once. 

6 Click on the button "Export .kish to .csv" to export the Kish 

Method data from the PDA to a .csv file (comma-delimited file).   

7 Modify the name of the file to include a number (e.g. the unique 

number you have assigned to the PDA) and be sure to save the 

.csv file in the C:\STEPS\data\Kish data folder.  

Continued on next page 
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Appending Kish Method Data, Continued 

 
Copying the 

Kish Method 

data files to 

your computer, 

cont. 

 

Step Action 

8 A pop-up window should appear informing you that the export 

was successful.  Click "OK" to finish. 

9 Repeat steps 3-8 for each PDA, being very careful not to 

download the data from the same PDA more than once. 

  

 
Appending the 

Kish Method 

data files 

Once all the Kish Method data files, you should see all the files in your 

C:\STEPS\data\Kish data folder, as in the image below. 

 

 
 

The Excel file Kish_Method_Data.xls has been created by the STEPS team to 

assist you in appending all the data in these files.  The Kish_Method_Data.xls 

file is available on the STEPS CD as well as on the eSTEPS website: 

http://www.who.int/chp/steps/esteps 

 

Download the Kish_Method_Data.xls file and save it to the C:\STEPS\data 

folder.  Open the file and press "Ctrl + m" to automatically append all the 

Kish Method data files into this file. 

 
Attaching the 

Kish Method 

data to the 

dataset 

Once all the Kish Method Data has been appended together in the 

Kish_Method_Data.xls file, you may run the program 

AttachKishMethodData in Epi Info to attach the Kish Method data to your 

dataset only if you are certain that there are no duplicate Participant IDs in 

either your data set or in your Kish data. 

 

Information on how to use Epi Info is provided in the STEPS Manual, Part 3 

Section 6 and Part 4 Section 3, as well as the Epi Info Training Guide, which 

is available on the STEPS website and CD.  For further assistance, please 

contact the STEPS team (steps@who.int). 

 


